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MODELAREA BATIMETRICĂ – PREMISA 

PENTRU CREAREA DE MODELE ALE CURGERII 

ȘI TRANSPORTULUI DE SEDIMENTE 

1. INTRODUCERE 
 

În domeniul hidrotehnicii, modelarea reprezintă un instrument extrem de eficient de 

rezolvare a unor probleme concrete prin reproducerea fenomenelor studiate cu ajutorul unor 

modele hidraulice. 

În general, prin ,,model” înțelegem ansamblul de obiecte, inclusiv simboluri sau 

reprezentări simplificate, care se află într-un raport de corespondență cu fenomenul supus 

cunoașterii [1].   

Un model reușit este mai accesibil pentru cercetări decât obiectul real și permite 

obținerea unor informații noi despre acesta. Procesul de construire a modelului poartă numele 

de modelare.  

Hidraulica, asemenea celorlalte ştiinţe ale naturii, foloseşte în investigări metode 

teoretice şi metode experimentale.  

Modelarea hidraulică s-a dezvoltat ca metodă științifică de cercetare începând cu 

secolul al XX-lea, atunci când s-au pus bazele analizei dimensionale (instrument al metodei 

teoretice) și teoriei similitudinii (baza teoretică a modelării hidraulice).  

În natură, există fenomene fizice foarte complexe al căror mecanism nu este încă 

suficient de bine studiat, ceea ce conduce la imposibilitatea stabilirii ecuaţiilor generale ale 

fenomenului şi a formulării condiţiilor de unicitate corespunzătoare. În aceste situații, se aplică 

metode generale de cercetare, care sunt mai puţin exacte, dar care permit determinarea formei 

generale a legilor de desfăşurare a fenomenelor fizice. Astfel, dacă se cunosc mărimile fizice 

𝐴1, 𝐴2, ..., 𝐴𝑛, care intervin în desfăşurarea unui fenomen, şi se presupune existenţa numai a 

unei singure funcţii necunoscute între ele f(𝐴1, 𝐴2, ..., 𝐴𝑛), atunci pot fi stabilite unele legături 

între aceste mărimi utilizând natura lor dimensională [2]. În plus, trebuie ţinut seama de faptul 

că relaţiile fizice reprezintă relații între mărimi fizice (dimensionale), pe când relaţiile 

matematice operează cu numere abstracte. Acest mod de cercetare este cunoscut în ştiinţă sub 

numele de analiză dimensională și se folosește atunci când, pe bază experimentală, pot fi 

cunoscuți parametrii hidraulici ai fenomenului studiat.  

În ceea ce privește teoria similitudinii hidraulice 1 , enunțarea acesteia a oferit 

posibilitatea ca fenomenele complexe din natură să poată fi studiate pe modele la scară redusă, 

iar rezultatele obținute să poată fi extinse, după anumite legi, la o clasă întreagă de asemenea 

fenomene.  

Similitudinea poate fi geometrică, cinematică sau dinamică, în funcţie de 

proporţionalitatea mărimilor determinante.  

 Similitudinea geometrică este cea mai simplă formă de similitudine. Între fenomenul pe 

model (M) şi fenomenul pe prototip (N) există o similitudine geometrică dacă este 

                                                           
1 Două fenomene, M (model) și N (natură) sunt similare dacă fac parte din aceeași clasă și dacă între mărimile 

omoloage cu care se descriu aceste fenomene există relații de proporționalitate [17].   
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asigurată proporţionalitatea lungimilor omoloage şi egalitatea unghiurilor. Unui punct 

pe model îi corespunde un singur punct pe prototip (obiectul real) şi reciproc, cele două 

puncte dispuse identic pe model şi prototip purtând numele de puncte omoloage. Aceste 

puncte omoloage pot determina drepte omoloage, suprafeţe omoloage şi volume 

omoloage. Prin urmare, similitudinea geometrică presupune o scară unică pentru lungimi 

(𝑆𝑙): 

𝑆𝑙 =
𝑙𝑀

𝑙𝑁
 ;                                                          (1-1) 

Similitudinea geometrică poate fi asigurată prin realizarea modelului la scară, 

nedistorsionat geometric. Scara geometrică mai este cunoscută sub denumirea de scară 

de modelare. 

 Similitudinea cinematică reprezintă similitudinea mişcării și implică, în puncte 

omoloage, similitudinea geometrică a câmpului hidrodinamic (aspectul curgerii este 

acelaşi pe model şi prototip) şi raport constant al mărimilor cinematice de acelaşi tip 

(viteze, acceleraţii). Odată stabilită scara lungimilor, rezultă un raport constant al 

timpului în care se desfăşoară fenomenul pe prototip şi timpul în care se desfăşoară 

fenomenul pe model, adică scara timpului (𝑆𝑡):  

𝑆𝑡 =
𝑡𝑀

𝑡𝑁
 ;                                                         (1-2) 

 Similitudinea dinamică impune ca raportul tuturor forţelor din natură, de pe prototip şi 

de pe model, să fie constant. Rezultă, astfel, scara forţelor (𝑆𝑓): 

 𝑆𝑓 =
𝑓𝑀

𝑓𝑁
 ;                                                         (1-3) 

Realizarea pe un model hidraulic a acestor condiții nu este însă posibilă în totalitate, din 

cauza varietății forțelor care determină mișcarea fluidului, ceea ce atrage o serie de condiții 

greu de îndeplinit referitoare la constantele fizice ale fluidelor. În practica modelării hidraulice 

se apreciază mai întâi forțele dominante ale fenomenului de modelat și se impune apoi condiția 

de similitudine dinamică numai acestor forțe. În acest fel se obțin diferite modele („criterii de 

similitudine”) după categoria de forțe luate în considerare. Aceste criterii se pot exprima prin 

mărimi adimensionale numite numere caracteristice.  

Altfel spus, dacă un fenomen fizic concret este descris de mai multe mărimi fizice de 

aceeași natură (cu aceleași dimensiuni), orice raport a două dintre aceste mărimi reprezintă un 

complex adimensional, care se notează de obicei cu litera π, însoțită de un indice. Complexele 

adimensionale pot fi privite și ca numere, deoarece ele rezultă din raportul a două mărimi de 

aceleași dimensiuni.                

Considerând câteva dintre mărimile fizice determinante în descrierea fenomenelor din 

cadrul mecanicii fluidelor, şi anume: lungimea caracteristică l, viteza fluidului u, densitatea 

fluidului ρ, coeficientul dinamic de vâscozitate al fluidului μ, presiunea p, acceleraţia 

gravitaţională g, viteza sunetului a şi coeficientul de tensiune superficială σ, se pot forma 

următoarele criterii utilizând aceste mărimi [3]: 

 Criteriul Reynolds - constituie condiția de bază pentru modelul în care forțele de 

vâscozitate sunt dominante:  

      𝑅𝑒 =
𝑢𝑙𝜌

𝜇
 = 

𝑢𝑙

𝑣
 ;      (1-4) 
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 Criteriul Euler - se folosește atunci când, pe lângă forțele de inerție, trebuie luate în 

considerare și forțele de presiune: 

𝐸𝑢 =
𝑝

𝜌𝑢2 ;       (1-5)  

 Criteriul Froude - se utilizează la modelarea mișcărilor la care forța de greutate este 

predominantă: 

  𝐹𝑟 =
𝑢2

𝑔𝑙
 ;                                                        (1-6) 

 Criteriul Mach - intervine la modelarea mișcărilor la care se ține cont de 

compresibilitatea fluidului: 

          𝑀𝑎 =
𝑢

𝑎
 ;                               (1-7) 

 Criteriul Weber - se folosește la modelarea acelor mișcări la care, pe lângă forțele de 

inerție, forța de tensiune superficială este predominantă: 

  𝑊𝑒 =
𝜌𝑢2𝑙

𝜎
 ;                             (1-8) 

 Atunci când mișcarea este nepermanentă, se introduce criteriul Strouhal: 

  𝑆ℎ =
𝑙

𝑢𝑡
 ;                             (1-9) 

unde t reprezintă timpul caracteristic. 

Teoria similitudinii hidraulice demonstrează faptul că nu pot fi aplicate simultan toate 

criteriile, cea mai cunoscută incompatibilitate fiind Re și Fr. Rezolvarea situațiilor de acest tip 

se face prin elaborarea unor modele cu distorsiuni hidraulice, adică se renunță la unul dintre 

cele două criterii incompatibile.   

Modelarea hidraulică sau hidrodinamică operează cu două tipuri de modele: modele 

fizice și modele numerice [4].  

Modelele fizice se disting prin particularitatea de a reproduce fenomenele studiate la o 

altă scară decât cea naturală. În cazul fenomenelor hidraulice, care se produc în spații întinse, 

modelele fizice se realizează la scară redusă [5].   

 În ultimele decenii, datorită dezvoltării tehnicii de calcul automat, precum și a metodelor 

matematice de integrare a ecuaţiilor diferenţiale, modelele numerice sau matematice au 

cunoscut o dezvoltare rapidă. Ele sunt aplicate în diferite ramuri ale hidraulicii, precum curgeri 

cu nivel liber uni și bidimensionale, curgeri sub presiune, curgeri subterane etc. Aceste modele 

reprezintă seturi de relații matematice între parametrii care descriu un anumit fenomen fizic.  

 Modelele matematice se pot construi pe două căi principial diferite, cele două tipuri 

fiind cunoscute sub numele de modele deterministe și modele stochastice, care reflectă 

metodele fizicii clasice, respectiv ale fizicii statistice pentru descoperirea și studiul legilor care 

guvernează fenomenele naturale.  

Modelele deterministe se referă la fenomenele descrise de un număr relativ mic de 

parametri. Legile care exprimă legătura dintre parametrii ce descriu unul sau mai multe 

fenomene iau forma unor ecuații denumite ecuațiile fizicii matematice. 

Modelele stochastice au la bază statistica matematică. Prin analizarea unui număr mare 

de evenimente, statistica poate descoperi legile care le guvernează, independent de felul în care 

acestea sunt determinate (fără a urmări relația cauză-efect), prin intermediul corelațiilor. 

O tendinţă actuală constă în utilizarea complementară a modelelor fizice și numerice, 

deoarece modelul fizic oferă datele necesare pentru calibrarea modelului numeric. 
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2. PRINCIPIILE MODELĂRII HIDRAULICE  
 

Una dintre cele mai importante probleme ale hidraulicii o constituie mișcarea cu 

suprafață liberă a apei în râuri și canale (sau în conducte cu secțiunea parțial plină).  

Mișcările cu suprafață liberă (sau cu nivel liber) reprezintă mișcările lichidelor care se 

produc astfel încât în lungul curentului există o suprafață liberă în contact cu atmosfera [6].  

În funcție de variația în timp și spațiu a parametrilor hidraulici (debit, viteză, adâncime, 

pantă, suprafață și perimetru udat), mișcarea cu suprafață liberă din albiile râurilor poate fi 

clasificată, conform Figurii 1, astfel [7]: 

 
Figura 1. Clasificarea tipurilor de mișcare cu suprafață liberă 

Tipul de curgere este influențat în mod direct de modificările suferite de albia râului. 

În general, curgerea în albii deschise are un caracter nepermanent și neuniform, din cauza 

modului de alimentare a cursurilor de apă, dar și din cauza neuniformităților frecvente în albie. 

Cu toate acestea, în ipoteza în care variația debitelor și a nivelurilor este lentă, pentru perioade 

scurte de timp, curgerea poate fi considerată permanentă (uniformă sau neuniformă)2.  

Mișcările nepermanente cu suprafață liberă prezintă un caracter ondulatoriu și iau 

naștere ca urmare a modificării condițiilor la limită, prin schimbarea debitelor sau a nivelurilor. 

Aceste perturbații, care se transmit cu viteză finită sub formă de unde, modifică simultan și 

debitul, și nivelul. Întrucât transmiterea modificărilor de nivel conduce la modificarea formei 

suprafeței libere, orice mișcare nepermanentă cu suprafață liberă poate fi recunoscută după 

variația în timp a formei suprafeței libere, cum se întâmplă, de exemplu, în cazul valurilor .  

Fiind un fenomen neliniar, cu diferite forme de manifestare, calculul mișcărilor 

nepermanente cu suprafață liberă este foarte complicat.  

În cazul mișcărilor nepermanente în râuri și canale, pe lângă fenomenul ondulatoriu de 

propagare a perturbațiilor, intervine și fenomenul de transport, de mișcare a apei cu o anumită 

viteză.   

                                                           
2 Tipurile de mișcare permanentă (uniformă, neuniformă gradual variată și neuniformă rapid variată) au fost 

prezentate în Referatul nr. 2 - Hidrologie și hidraulica râurilor.  



   Raport de cercetare nr. 2  

Modelarea batimetrică – premisa pentru crearea de modele ale curgerii și transportului de sedimente 

9 
 

Modelarea matematică a curgerii în albie constă în simularea condiţiilor de curgere, 

bazate pe formularea şi soluţionarea relaţiilor matematice care exprimă ecuaţiile de mișcare ale 

apei în albia râului. 

În mișcare nepermanentă, viteza apei are componente și în planul secţiunii transversale 

a albiei [8], iar pentru modelarea matematică a mișcării nepermanente este necesar să se apeleze 

la schematizări simplificate care să cuprindă doar aspectele cu influenţă esenţială asupra 

proceselor reale și, de multe ori, să se ignore cele de importanţă secundară. 

După stabilirea ecuaţiilor care modelează procesul fizic în aspectele lui principale, 

tratarea matematică sau numerică a acestora, executată în mod corect, nu schimbă natura fizică 

a procesului analizat.  

De cele mai multe ori, se realizează o schematizare unidimensională, astfel încât 

curgerea nepermanentă în albii să fie descrisă prin evoluţia în timp, în orice secţiune 

transversală, a două variabile dependente, și anume: cota suprafeţei libere a apei y (sau 

adâncimea apei h) și debitul Q (sau viteza medie în secţiune v). Aceste variabile dependente 

definesc starea mișcării în raport cu două variabile independente: poziţia spaţială în lungul 

albiei x (faţă de o origine aleasă convenabil) și timpul t (faţă de momentul apariţiei perturbaţiei). 

Variabilele dependente și independente care apar în curgerea nepermanentă în albii sunt 

legate între ele prin două ecuații care provin din legile de conservare ale masei, cantității de 

mișcare și energiei mecanice. 

Ipotezele care stau la baza modelului unidimensional, împreună cu ecuaţiile ce descriu 

mișcarea unidimensională nepermanentă, au fost formulate de Barré de Saint-Venant în 1871, 

la Academia Franceză, în lucrarea “Théorie et equations generales du mouvement non-

permanent des eaux courantes”. 

În literatura de specialitate, ecuaţiile fundamentale ale mișcării nepermanente în albii 

deschise sunt denumite ecuaţiile Saint-Venant. Pentru analiza mișcării apei în canale se pot 

utiliza mai multe forme ale ecuaţiilor Saint-Venant, care, faţă de forma lor iniţială, au suferit în 

timp generalizări si îmbunătăţiri.  

Ecuaţiile Saint-Venat reprezintă de fapt un sistem de ecuaţii cu derivate parţiale de 

ordinul II, neliniare, de tip hiperbolic: 

 ecuația de continuitate, exprimând principiul conservării și continuității fazei 

lichide: 
𝜕𝑄

𝜕𝑥
+

𝜕𝐴

𝜕𝑡
= 0;               (2-1) 

 ecuația de mișcare, exprimând principiul conservării și continuității energiei: 

 
𝜕𝑄

𝜕𝑡
+

𝜕(𝑄·𝑉)

𝜕𝑥
+ 𝑔 · 𝐴 · (

𝜕ℎ

𝜕𝑥
− 𝑆0) + 𝑔 · 𝐴 · 𝑆𝑓 = 0;               (2-2) 

unde: S0 reprezintă panta fundului albiei, Sf  – panta de frecare, V este viteza considerată 

uniformă în secţiune transversală, iar A – aria secţiunii vii; V și A sunt funcţii de x și t, astfel 

încât debitul va fi:            

     𝑄 =  𝐴 ·  𝑉 = 𝑄(𝑥, 𝑡)                               (2-3) 

Soluționarea exactă a sistemului de ecuații Saint-Venant, în sensul obținerii valorilor 

necunoscute (variabilelor dependente) în toate punctele planului variabilelor independente este 

practic imposibilă.  
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3. CONSTRUIREA MODELULUI BATIMETRIC 2D 
 

3.1. Noțiuni generale 

 

În ultimele decenii, s-au înregistrat progrese remarcabile în ceea ce privește studiul 

proceselor de curgere și transport sedimentar pe râuri și fluvii, prin utilizarea instrumentelor de 

modelare a curgerii, morfologiei albiei și a transportului de sedimente. 

În general, la modelarea cursurilor de apă cele mai utilizate sunt modelele 

unidimensionale (1D), care au la bază ecuațiile curgerii uniforme și pe cele ale curgerii uniform-

variate. Aceste modele prezintă următoarele avantaje: simplitatea calculelor, uşurinţa 

parametrizării, calibrarea facilă, număr mai mic de date necesare pentru calibrare/validare [9]. 

Elaborarea unui model numeric al deplasării masei de fluid, în special în perioada 

viiturilor, reprezintă un proces complex, întrucât se bazează pe sistemul de ecuaţii Saint-

Venant, în care intervin parametri precum rugozitatea din fiecare secţiune de calcul. Aceşti 

parametri sunt diferiţi pentru albia minoră, respectiv pentru albia majoră, sau pot fi consideraţi 

variabili pe verticală. Calibrarea lor presupune ajustarea valorilor acestora (în limite 

acceptabile) până la reproducerea cu acurateţe a nivelurilor înregistrate pentru situaţii care au 

fost foarte bine monitorizate.  

Modelele hidrodinamice de propagare 2D sunt capabile să reproducă într-un mod foarte 

realist fenomene distribuite spațial, deși sunt mai dificil de calibrat și validat decât modelele 

1D, întrucât datele necesare se obțin prin intermediul tehnologiilor moderne de măsurare. De 

asemenea, modelele hidraulice 2D necesită un timp de calcul mai mare, iar datele necesare 

pentru construcţia geometriei trebuie să aibă o distribuţie spaţială mult mai mare [9].            

Modelele bidimensionale pot fi împărțite în trei categorii: modele quasi 2D, modele 

complet 2D și modele combinate 1D-2D. Există și situații în care se impune o abordare 

tridimensională a curgerii, în special când aceasta trece din albie în lunca inundabilă [10]. 

 

3.2. Obiectivele cercetării 

 

În cadrul proiectului de cercetare intitulat ,,Contribuții privind utilizarea măsurătorilor 

geodezice în vederea modelării transportului sedimentar pe Dunăre”, care își propune 

identificarea unor măsuri care să contribuie la stabilizarea patului albiei fluviului Dunărea,   

obiectivul raportului de cercetare nr. 2 - ,,Modelarea batimetrică – premiza pentru crearea 

de modele ale curgerii și transportului de sedimente” îl reprezintă crearea unui model 

complex hidrodinamic (2D) al sectorului  dunărean analizat, având la bază diversele tipuri de 

măsurători geodezice pentru determinarea elementelor necesare (tipurile de măsurători 

geodezice au fost prezentate în detaliu în cadrul raportului de cercetare nr. 1 - ,,Stadiul actual 

privind măsurători geodezice și Sisteme de Coordonate de Referință”).   

Rezultatele acestui raport vor fi folosite mai departe în raportul de cercetare nr. 3 - 

,,Studiu de caz și interpretarea rezultatelor”, care va trata îndeosebi problematica modelării 

transportului sedimentar pe Dunăre, prin realizarea unui model de eroziune, urmată de 

calibrarea și validarea acestuia. 
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3.3. Zona de studiu  

Zona de studiu (Figura 2) propusă pentru a fi modelată hidrodinamic se referă la sectorul 

dunărean situat amonte de staţia hidrometrică Bechet (km 678) şi aval de staţia hidrometrică 

Corabia (km 625).  

 
Figura 2. Zona de studiu 

Acest sector este reprezentativ pentru proiectul de cercetare, deoarece, pe cei 

aproximativ 53 de km pe care îi măsoară cursul de apă, navigația se desfășoară cu mare 

dificultate, din cauza complexității regimului hidraulic și a schimbărilor dinamice ale 

morfologiei albiei fluviului, cu efecte nefavorabile asupra şenalului navigabil3.  

Serviciile de transport pe Dunare viabile din punct de vedere economic sunt dependente 

de condițiile unui șenal navigabil stabil. De-a lungul Dunării, navigația este împiedicată de mai 

multe blocaje sau puncte critice, atât în timpul iernii, când apar sloiuri de gheață, cât și în 

timpul verii, când nivelul Dunării este foarte scăzut (debitul înregistrat este mai mic de 3000 

m3/s).  

În conformitate cu prevederile ,,Convenției despre regimul navigației pe Dunăre”, 

semnată la Belgrad la 18 august 1948, asigurarea condițiilor de navigație pe sectorul de Dunare 

                                                           
3 Șenalul navigabil reprezintă o porțiune navigabilă în lungul unui curs de apă, a unui canal sau pe suprafața unui 

lac. Constituie o cale continuă, cu lățime și cu adâncime suficiente pentru a asigura circulația navelor, pătrunderea 

navelor în port sau pentru trecerea acestora printr-un loc îngust. Șenalul navigabil este amenajat și balizat în scopul 

desfășurării navigației în condiții de siguranță. Sursa: www.wikipedia.org. 



   Raport de cercetare nr. 2  

Modelarea batimetrică – premisa pentru crearea de modele ale curgerii și transportului de sedimente 

12 
 

cuprins între km 845,5 și km 375 se află în responsabilitatea celor două țări riverane, România 

și Bulgaria. 

În baza Acordului bilateral româno-bulgar, semnat la Sofia la 28 noiembrie 1955, cele 

două state și-au definit sectoarele de responsabilitate, pe sectorul comun de Dunăre, după cum 

urmează: 

- între km 845,5 și km 610, responsabilitatea întreținerii căii navigabile aparține părții 

române; 

- între km 610 și km 375, responsabilitatea întreținerii căii navigabile aparține părții 

bulgare. 

AFDJ Galați (România) și IAPPD Ruse (Bulgaria) sunt autoritățile responsabile pentru  

menținerea condițiilor adecvate de navigabilitate. 

Regia Autonomă Administrația Fluvială a Dunării de Jos (AFDJ) este autoritatea de cale 

navigabilă pe tot sectorul românesc al Dunării. Pentru asigurarea condițiilor minime de 

navigație, recomandate de Comisia Dunării, se execută lucrări de întreținere (activități de 

măsurători, semnalizare și dragaj), care sunt eficiente doar o scurtă perioadă de timp.   

De aceea, în anul 2017 a fost demarat proiectul “FAST Danube” - „Asistență tehnică 

pentru revizuirea și completarea studiului de fezabilitate privind îmbunătățirea condițiilor de 

navigație, pe sectorul comun Româno-Bulgar al Dunării și studii complementare”, care să 

studieze condițiile geomorfologice și hidrologice care influențează acest sector de Dunăre, în 

scopul elaborării unor soluții tehnice complexe care să ajute la îmbunătățirea condițiilor de 

navigație și totodată să aibă un impact minim asupra mediului.  

În urma unui studiu de fezabilitate necesar demarării proiectului, finalizat în anul 2011, 

în sectorul fluvial aval de Porțile de Fier II, în secțiunea comună româno-bulgară (km 845,5 – 

km 375), au fost identificate 12 puncte critice pentru navigație (Tabelul 1), care necesită o 

monitorizare atentă, printr-o serie de măsurători topo-hidrografice.  

Tabelul 1. Puncte critice pentru navigație 

NR. 

CRT. 
DENUMIRE 

LOCALIZARE (KM 

FLUVIAL) 

TERITORIU 

ADMINISTRATIV 

1 Gârla Mare km 839 – km 837 România 

2 Salcia km 824 – km 820 România 

3 Bogdan-Secian km 786 – km 782 România 

4 Dobrina km 762 – km 756 România 

5 Bechet km 678 – km 673 România 

6 Corabia km 632 – km 626 România 

7 Belene km 577 – km 560 Bulgaria 

8 Vardim km 542 – km 539 Bulgaria 

9 Iantra km 537 – km 534 Bulgaria 

10 Batin km 530 – km 520 Bulgaria 

11 Kosui km 428 – km 423 Bulgaria 

12 Popina km 408 – km 401 Bulgaria 
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Ca urmare a acestui studiu, Comisia Dunării a recomandat pentru sectorul româno-

bulgar o lățime a șenalului de 180 m, cu o adâncime minimă de 2,5 m și raza minimă de curbură 

de 1000 m. Pentru zonele în care adâncimile minime nu sunt asigurate (Figura 3), s-a propus  

reducerea lățimii șenalului până la 150 m. 

 

Figura 3. Amplasarea celor 12 puncte critice în sectorul românesc și în sectorul bulgăresc 

        Sursa: http://www.fastdanube.eu/official-documents 

Așadar, zona de studiu Bechet-Corabia face parte din zonele critice pentru navigație  

stabilite, conform aceluiași studiu de fezabilitate, conform Tabelului 2. 

Tabelul 2. Zone critice pentru navigație 

NR. ZONĂ 

CRITICĂ 
LUNGIME (KM FLUVIAL) 

PUNCTE CRITICE INCLUSE ÎN ZONA 

CRITICĂ 

ZC1 km 850 – km 818 Gârla Mare, Salcia 

ZC2 km 786 – km 755 Bogdan-Secian, Dobrina 

ZC3 km 678 – km 625 Bechet, Corabia 

ZC4 km 577 – km 520 Belene, Vardim, Iantra, Batin 

ZC5 km 428 – km 401 Kosui, Popina 

 

 

 

 

http://www.fastdanube.eu/official-documents
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3.4. Date de intrare în model 
 

Înțelegerea proceselor morfologice ale unui râu sau fluviu în contextul modelării 

hidrodinamice, precum și modelarea transportului de sedimente reprezintă un subiect dificil, 

care necesită o cantitate mare de date măsurate și cunoștințe interdisciplinare.  

Calitatea modelării matematice și reprezentarea spațială a rezultatelor acesteia sunt 

strâns legate de datele de intrare utilizate. Calitatea acestor date este cu atât mai importantă cu 

cât influențează în mod direct reprezentarea fenomenelor naturale într-o formă cât mai aproape 

de realitate.  

În consecință, există o mare cerere pentru informații corecte și precise, pentru a 

minimiza incertitudinile din rezultatul simulărilor .  

 

3.4.1. Date topografice  

Punctul de plecare în elaborarea oricărui model hidrodinamic al curgerii îl reprezintă 

datele legate de teren, topografia terenului și acoperirea terenului [11].    

În funcție de tipul de modelare matematică utilizat, și anume unidimesională sau bi-

dimensională, datele topografice necesare sunt diferite. 

Modelarea 1D se pretează la o abordare clasică a colectării, unde metodele de culegere 

a datelor folosind tehnologia GNSS și staţia totală vor înlocui LiDAR-ul aeropurtat și 

fotogrammetria aeriană, folosite la obținerea datelor geospaţiale necesare modelării 2D [12].  

Pentru generarea unui model unidimensional al râurilor, sunt necesare profile grafice 

longitudinale și transversale, acestea din urmă fiind dispuse perpendicular pe axul longitudinal 

al râului, iar poziţia şi densitatea lor se alege în funcție de configurația terenului și de importanța 

zonei în care acestea se află. La colectarea datelor trebuie să se țină cont de precizia solicitată, 

ea având un rol esenţial la alegerea echipamentului şi a metodelor de măsurare.  

Prelucrarea finală a datelor în vederea utilizării lor în programele de modelare 

matematică 1D a râurilor conţine mai multe etape independente, multe dintre ele fiind prelucrări 

manuale care necesită mult timp și facilitează apariţia erorilor umane. De asemenea, această 

metodă nu oferă un randament ridicat.  

În cazul modelelor bidimensionale, profilele transversale/măsurătorile batimetrice în 

albia minoră sunt cuplate cu seturi de date topografice în albia majoră, pentru generarea unui 

Model Digital al Terenului (MDT) continuu [11]. Datele topografice se colectează separat 

pentru zonele uscate și pentru cele acoperite de apă şi se procesează, de asemenea, separat. 

Acestea trebuie însă incluse într-un MDT unitar, care să acopere întreaga zonă de studiu. 

În cazul de față, pentru modelarea hidraulică bidimensională a sectorului dunărean 

Bechet-Corabia (53 km lungime), modelul digital al terenului ne-a fost pus la dispoziție prin 

amabilitatea AFDJ Galați (S.C.N. Giurgiu), beneficiarul proiectului FAST Danube.   

Acest MDT a fost obținut pe baza datelor culese prin tehnologie LiDAR (Light 

Detection and Ranging), combinate cu date topo-geodezice și batimetrice, el acoperind întreaga 

zonă modelată, inclusiv albia minoră.  
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a) Stabilirea bornelor geodezice de referință 

În cadrul proiectului ,,Realizarea unui sistem de sprijin pentru lucrările hidrografice pe 

Dunăre în scopul asigurării adâncimilor minime de navigare”, al cărui beneficiar este statul 

român, iar autoritatea contractantă este AFDJ Galați, obiectivul principal a fost proiectarea și 

materializarea a câte trei borne geodezice (Borna Martor, Borna de Referință și Borna 

Azimutală) în 144 de locații din lungul Dunării. Sistemul, denumit AFDJ2014, e definit așadar 

de cele 144 de locații, situate la mai puțin de 15 km una față de cealaltă.  

Pe sectorul analizat, Bechet-Corabia, există șase locații în care au fost amplasate borne 

din rețeaua de sprijin AFDJ2014 (91-86), ilustrate în Figura 4. 

 

Figura 4. Rețeaua de sprijin AFDJ2014 pe sectorul Bechet-Corabia       

Coordonatele finale ale bornelor au fost furnizate atât în sistem ETRS89 (pentru a 

facilita interconectarea cu țările vecine), cât și în sistemul national de referință S42 (cu 

elipsoidul aferent Krasovski 1940 și sistem de proiecție stereografic 1970). Pe lângă setul de 

coordonate planimentrice și geodezice (determinate cu tehnologie GNSS), fiecărei borne i s-a 

determinat și coordonata altimetrică în sistemul normal de altitudini Marea Neagră 1975 (cota 

a fost transmisă prin nivelment geometric de la reperii din rețeaua națională), care mai apoi a 

fost transformată cu TransDatRo în sistemul EVRF2007 (punct fundamental Amsterdam).  

Tot prin intermediul soft-ului TransDatRo, coordonatele planimetrice au fost calculate 

și în sistemul de proiecție UTM (Universe Transverse Mercator), utilizat în Bulgaria.  

Această rețea de sprijin stă la baza redeterminării corecte a ,,cotei 0” a mirelor 

hidrometrice, facând astfel posibilă determinarea cât mai precisă a cotei absolute a suprafeței 

libere a apei. De asemenea, aceste puncte de referință au fost folosite ca stații de bază în care 

au fost instalate echipamente GNSS pentru generarea corecțiilor diferențiale, care au fost  

transmise ulterior prin unde radio către receptorul GNSS din barca dotată cu sonar (din care s-

au efectuat măsurătorile batimetrice). Precizia de determinare a acestor puncte, în special a 

cotelor, influențează semnificativ rezultatele finale: MDT-ul și modelul matematic al curgerii. 
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b) Date provenite din scanări LiDAR 

Tehnica LiDAR presupune existența unui senzor laser montat cu foarte mare precizie 

pe un avion, elicopter sau UAV (Unmanned Aerial Vehicle - Vehicul Aerian Fără Pilot - dronă), 

care transmite în timpul zborului o undă laser către suprafața terenului, iar un receptor montat 

în spatele avionului recepționează undele laser reflectate de aceasta.   

 Majoritatea sistemelor LiDAR folosesc o oglindă de scanare pentru generarea unei benzi 

de impulsuri laser. Lungimea benzii depinde de unghiul de oscilare al oglinzii, iar densitatea 

punctelor de la sol depinde de factori precum viteza avionului și rata de oscilare a oglinzii.   

Distanțele se determină prin calcularea timpului necesar parcurgerii de către semnalul 

laser a distanței de la senzorul emițător până la sol și înapoi la acesta. 

 Pe lângă sistemul de scanare cu laser (Laser Scanner - Figura 5), tehnica LiDAR se 

bazează pe cuplul GNSS/IMU (sistem satelitar de navigaţie globală/unitate inerţială de 

măsurare), care ajută la determinarea cât mai exactă a poziției și orientării sistemului. 

Sistemul GNSS este compus dintr-o antenă GNSS aeropurtată (GNSS Receiver – figura 

4), montată într-o poziţie vizibilă în partea superioară a aeronavei, oferind o deschidere 

suficientă spre sateliţi, pentru a înregistra poziția continuă a avionului, și o stație GNSS 

amplasată la sol (GNSS Reference Station),  cu rolul de a corecta măsurătorile antenei GNSS, 

astfel încât să se obțină o traiectorie cât mai bună a aparatului de zbor (datele GNSS sunt 

prelucrate prin metode GNSS diferențiale).  

Sistemul IMU (Inertial Measurement Unit) constă într-un set de giroscoape și 

accelerometre care măsoară continuu înălțimea și accelerația avionului. 

 
              Figura 5. Componentele sistemului LiDAR 

                 Sursa: https://www.yellowscan-lidar.com/ 

 

În prezent, tehnologia de scanare laser furnizează date topografice de mare rezoluție și 

este capabilă să acopere rapid suprafețe întinse, la costuri moderate, cu o precizie ridicată atât 

în plan orizontal, cât și în cel vertical, contribuind în mod semnificativ la reprezentarea 

suprafețelor de teren.  

Coordonatele tridimensionale (x, y, z sau latitudine, longitudine şi altitudine) ale 

punctelor corespunzătoare obiectelor măsurate sunt calculate prin utilizarea a trei elemente 

https://www.yellowscan-lidar.com/
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principale, şi anume: diferenţa de timp dintre emisia şi întoarcerea pulsului laser, unghiul sub 

care a fost emis pulsul laser şi locaţia exactă a senzorului de pe suprafaţa Pământului sau 

deasupra acesteia.  

Chiar dacă pentru zonele străbătute de ape această tehnologie prezintă anumite limitări 

cauzate de faptul că impulsul laser nu pătrunde apele adânci, în mod cert reprezintă un 

instrument util pentru generarea modelelor digitale ale terenului cu o acuratețe ridicată în zone 

complexe precum văile inundabile sau insulele fluviale.  

În cadrul proiectului “Fast Danube”, în anul 2017 au fost realizate două campanii de 

scanare cu aeronave dotate cu echipamente LiDAR, în lunile aprilie și iulie, obiectivul fiind 

acoperirea a minim 200 m de la limita apei de fiecare parte a Dunării (pe sectorul comun 

româno-bulgar) și scanarea insulelor fluviale acoperite cu vegetație forestieră.  

 Pentru asigurarea celor mai bune date de intrare pentru procesul de modelare, zona de 

interes a fost extinsă până la valoarea de 250 m de la primul mal ferm (zonele de nisip au fost 

considerate parte din corpul de apă), în final rezultând o suprafață scanată de 1013 km2. 

 Pentru construirea modelului hidrodinamic al sectorului Bechet-Corabia au fost utilizate 

datele rezultate în urma primei campanii de măsurători, puse la dispoziție de AFDJ Galați.  

Aeronavele utilizate pentru scanarea LiDAR au fost SP-FPL- Cessna T206H (Figura 6) 

și SP-FPK Piper Navajo PA-31 (Figura 7).  

 

Figura 6. Cessna T206H, modificat pentru 

scanare LiDAR 

 

Figura 7. Piper Navajo PA-31, modificat 

pentru scanare LiDAR 
 Sursa: http://www.fastdanube.eu/official-documents 

Acestea au avut instalate sisteme identice de scanare, compuse din scanner-ul 

LiteMapper 6800i (Figura 8) și sistemul GPS/IMU AeroControl seria IIe 256Hz.  

Sistemul LiteMapper 6800i are în componență scanner-ul de ultimă generație Riegl 

LMS-Q680i, care utilizează principiul de măsurare prin unde continue și dispune de funcția 

inovativă Multi-Time Around, ce permite achiziția datelor de la înălțimi mari de zbor, de până 

la 3000 m AGL (Above Ground Level – deasupra nivelului solului), în funcție de suprafața 

scanată.  

Punctul de plecare pentru efectuarea planurilor de zbor a fost densitatea de scanare, 

obiectivul fixat fiind de 4 puncte/m2, însă, din analiza finală a reieșit faptul că densitatea a variat 

în funcție de acoperirea cu vegetație a fiecărei zone. 

http://www.fastdanube.eu/official-documents
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Lățimea unei benzi de scanare a fost de 570 m (pentru o altitudine medie de 690 m AGL 

și unghi de deschidere al scanner-ului de 45⁰). Viteza medie a fost de 125 kts (231.5km/h).   
Principalul rezultat al acestor scanări LiDAR îl reprezintă norii de puncte 3D, adică sute 

de milioane de puncte ce conțin informații de tipul x,y,z.      

 Acest volum imens de date nu a putut fi manipulat și procesat decât cu ajutorul stațiilor 

grafice puternice și al produselor software dedicate: RiAnalyze, RiWorld și RiProcess pentru 

procesarea datelor LiDAR, iar FugroViewer pentru vizualizarea norului de puncte.  

 

 

Figura 8. Sistem LiDAR LiteMapper 6800i instalat în aeronavă 

Sursa: http://www.fastdanube.eu/official-documents 

 

Calibrarea măsurătorilor LiDAR a fost realizată pe baza stațiilor GNSS permanente și a 

suprafețelor de control amplasate la sol.  

Spre deosebire de tehnicile topografice tradiționale de măsurare, această tehnologie a 

oferit posibilitatea generării unui MDT de înaltă rezoluție (0.5 m x 0.5m) direct din norul de 

puncte, în urma etapelor multiple de prelucrare a datelor, prin aplicarea algoritmilor de filtrare, 

segmentare şi clasificare a norilor de puncte. 

Verificarea preciziei coordonatelor obținute și evaluarea calității MDT derivat din date 

LiDAR s-a facut prin aplicarea unor teste de încredere, pe baza seturilor de date măsurate în 

teren.  

În timpul campaniei de măsurători terestre, pentru crearea bazei de control la sol, 

echipamentul utilizat a constat în: receptor GPS Trimble R8s compatibil ROMPOS (Figura 9), 

stație totală laser Trimble M3 (Figura 10) și un autovehicul pentru transport.  

 

 

 

 

 

 
         

Figura 9. Trimble R8s cu controller TSC3     Figura 10. Stație totală Trimble M3 

                                           Sursa: https://www.trimble.com/ 

http://www.fastdanube.eu/official-documents
https://www.trimble.com/
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c) Date provenite din măsurători batimetrice 

Tot în cadrul proiectului “Fast Danube” au fost efectuate două campanii de cartografiere 

batimetrică a albiei Dunării, de-a lungul sectorului comun româno-bulgar, în lunile aprilie-mai 

2017 (68 de zile – din aval, de la Călărași, în amonte, la Porțile de Fier II), repectiv iulie-august 

2017 (47 de zile – din amonte, de la Porțile de Fier II, spre aval, la Călărași).  

Datele hidrografice, hidrodinamice și cele privind sedimentele au fost colectate 

simultan. Pe toată durata determinărilor batimetrice, nava laborator ANR 1979 a fost utilizată 

ca bază mobilă suport cu staționare la fiecare 10-12 km (Figura 11). 

 

 

          Figura 11. Nava laborator ANR 1979 

Pentru colectarea datelor hidrografice au fost utilizate trei ambarcațiuni (Figura 

12.a,b,c) dotate cu sonare interferometrice Kongsberg GeoSwath Plus, care operează la 

frecvențe de 250 kHz și 500 kHz. O frecvență mai mare oferă o rezoluție mai bună, dar în 

același timp limitează raza de acțiune. Așadar, diferența între cele două clase de frecvență rezidă 

în lățimea fâșiei acoperite (swath width).  

 
 

  

                           a)                              b)                                                                 c) 

Figura 12. Ambarcațiuni utilizate 

 a) Șalupa Buster XL  b) Șalupa Shadow  c) Șalupă ZOPEDA 

Sursa: https://marine-research.com/ 

Frecvența de 500 kHz a fost utilizată în ape cu adâncimi mici și pe profilele transversale, 

iar cea de 250 kHz pentru scanarea zonelor cu ape adânci și pentru șenalul navigabil, toate 

echipele folosind software-ul GS4 pentru achiziția, calibrarea și procesarea datelor.  

https://marine-research.com/
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Sonarele interferometrice Kongsberg 

GeoSwath Plus (Figura 13) se compun din: 

transductor (“transducer”), unitate de punte (“deck 

unit”) și receptor GNSS. Transductorul este partea 

submersă a ansamblului, care emite și înregistrează 

semnalul acustic întors de la substrat, fiind conectat 

la unitatea de procesare aflată pe nava.  

Transductorul are conectat un mini senzor 

SVS (Sound Velocity Sensor) pentru determinarea 

continuă a vitezei de propagare a sunetului în apă, 

introdusă ulterior ca și corecție în procesare. Tot pe 

“transducer” este atașat ansamblul MRU (Motion 

Reference Unit) de senzori inerțiali de poziție și 

compensare a mișcărilor ambarcațiunii. 

Figura 13. Componentele sonarului interferometric Kongsberg GeoSwath Plus 

Sursa: Alfred Wegener Institute Helmholtz Center for Polar and Marine Research 

Ca mod de funcționare, sonarul interferometric este asemănător cu sonarul cu scanare 

laterală (Side Scan Sonar)4, deoarece impulsurile acustice sunt emise în mod similar, însă pentru 

recepția semnalelor reflectate se utilizează o matrice de mai multe elemente transductoare 

amplasate la distanțe bine determinate între ele (Figura 14). Adâncimea diferitelor puncte de 

pe fundul albiei râurilor (sau mărilor) este precis calculată prin măsurarea diferenței de fază 

dintre semnalele recepționate la nivelul elementelor transductoare (corespunzătoare aceluiași 

punct), din care rezultă unghiurile dintre acestea, și prin cunoașterea exactă a vitezei de 

propagare a sunetului în coloana de apă (aproximativ 1500 m/s) și a timpului scurs între emisia 

și recepția semnalului. 

 

  Figura 14. Modul de funcționare a sonarului interferometric 

Sursa: International Hydrographic Organization 

                                                           
4 Sonarul cu scanare laterală (Side Scan Sonar) a fost descris în Raportul de cercetare nr. 1 - ,,Stadiul actual 

privind măsurători geodezice și Sisteme de Coordonate de Referință” (p.115).  
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Pe de altă parte, sateliţii artificiali ce evoluează pe orbite circumterestre emit semnale 

satelitare difuzate în domeniul microundelor, în mod continuu sau prin impulsuri, la intervale 

regulate de timp, care sunt recepționate de către receptorul GNSS, care decodifică acest semnal 

pentru a extrage informaţiile necesare determinării poziţiei receptorului, transmiţând către sonar 

coordonatele de poziţie şi timpul la care s-a efectuat determinarea.  

Pentru reducerea erorilor de poziţionare (cuprinse în limita a 3÷5 m) au fost utilizate  

corecțiile diferențiale primite de la stațiile de bază de pe mal (puncte din rețeaua de sprijin 

AFDJ2014), în care au fost instalate echipamente GNSS (Figura 15). În urma aplicării acestor 

corecții, a rezultat o precizie orizontală de 16 mm + 1 ppm din lungimea bazei (distanța stație 

de bază-rover) și o precizie verticală de 30 mm + 1 ppm din lungimea bazei. 

Deoarece receptorul GNSS şi sonarul, deşi au sisteme de referinţă diferite, execută 

măsurători asupra aceluiaşi punct, este necesară corelarea datelor furnizate de cele două 

echipamente, astfel încât unui punct cu coordonate planimetrice determinate prin tehnologie 

GNSS să-i fie asociată valoarea corespunzătoare a adâncimii măsurate de sonar [13].  

Conform documentației tehnice a sistemului, precizia măsurării adâncimii cu sistemele 

GeoSwath Plus este de 3 mm. 

 

Figura 15. Transmiterea corecțiilor diferențiale din stațiile de bază de pe mal 

În realizarea măsurătorilor batimetrice s-a optat pentru utilizarea sonarelor 

interferometrice în defavoarea sonarelor multifasciculare (multibeam) din următoarele rațiuni: 

 Sonarele interferometrice pot carta și malurile până la suprafața apei datorita unghiului 

mare de transmitere a fasciculelor (240 grade); 

  Sonarele interferometrice oferă o acoperire de până la de două ori mai mare decât 

cele multifasciculare (multibeam) clasice, fiind mult mai eficiente în ceea ce privește timpul 

necesar și implicit costurile aferente;  

  Sonarele interferometrice asigură un număr mare de puncte măsurate, peste 5000 în 

lungul fâșiei scanate (swath), pentru fiecare ping (emisie de unde acustice). Pentru gama de 

adâncime prevazută pentru măsurători se emit cel puțin 10 pinguri/s, ceea ce înseamnă 7-8 

pinguri/metru liniar de profil, rezultând 400-800 puncte măsurate/mp; 

  Adâncimea este măsurată până la suprafața apei de la o distanță sigură de navigare 

față de diguri sau obstacole subacvatice; 
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  Sonarele interferometrice sunt proiectate special pentru operare în ape cu adâncime 

mică și foarte mică, în timp ce sonarele multifasciculare clasice oferă o acoperire redusă în 

aceste zone. 

Modelul digital al terenului rezultat din procesarea datelor batimetrice a fost integrat cu 

cel derivat din date LiDAR, rezultând un MDT unitar de înaltă rezoluție (50cm x 50 cm), care 

acoperă întreaga zonă de studiu (Figura 16) - albia minoră a fluviului și 250 m stânga-dreapta 

de la primul mal ferm.    

 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Figura 16. Vizualizarea și analiza MDT unificat folosind softul Global Mapper 

La final, pentru aprecierea calității MDT unificat s-a efectuat o analiză privind zonele 

de conectare a MDT obținut din date LiDAR cu MDT obținut din măsurători batimetrice și au 

fost determinați indicatorii globali de precizie și acuratețe în conformitate cu prevederile din 

caietul de sarcini.   

 

3.4.2. Date hidrologice 

Datele hidrologice necesare construirii modelului hidrodinamic 2D, respectiv stabilirii 

condițiilor la limită, au fost furnizate de către Institutul Național de Hidrologie și Gospodărire 

a Apelor (INHGA) și AFDJ Galați. Toate datele colectate au fost reorganizate și  procesate prin 

metode statistico-matematice (Microsoft Excel 2014). Acestea constau în: 

 Debite lichide medii zilnice și niveluri medii zilnice de la stațiile hidrometrice 

Bechet și Corabia pentru anul 2017 (sursa: INHGA); 
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 Cheia limnimetrică de la stația hidrometrică Corabia valabilă pentru anul 2017 

(sursa: INHGA); 

 Coeficienții de rugozitate pentru albia minoră și pentru albia majoră, stabiliți în urma 

analizei mai multor seturi de date puse la dispoziție de către AFDJ Galați - S.C.N. 

Giurgiu și a fișierului .shp Corine Land Cover (2012-2018) cu acoperirea terenului. 

 Cheia limnimetrică de la s.h. Corabia a fost pusă la dispoziție sub formă tabelară, iar 

nivelurile erau exprimate relativ. Transformarea acestor valori relative în niveluri absolute 

(Marea Neagră 1975) a fost posibilă prin raportarea la valoarea ,,zero” miră corespunzătoare 

s.h. Corabia (19.647 m), după cum se poate observa în Figura 17.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

3.4.3. Constituirea bazei de date geospațiale 

Problematica modelării transportului sedimentar pe Dunăre și îmbunătățirea, în general, 

a  proceselor de întreținere a căii navigabile este una de actualitate, deși a fost abordată și în 

trecut în cadrul mai multor proiecte și programe de cercetare.  

Construirea modelului matematic reprezintă un pas deosebit de important în atingerea 

obiectivelor acestui proiect de cercetare (prezentate în Proiectul programului de cercetare 

ştiinţifică, 2018).           

 În acest scop, au fost consultate materiale bibliografice care să ofere un cadru general 

Figura 17. Exemplu de analiză și procesare a datelor brute în vederea utilizării 

acestora ca date de intrare în modelul matematic  
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pentru cercetare: teze de doctorat, reviste de specialitate, tratate de geografie, studii hidrologice, 

studii regionale, site-uri web etc.  

Etapa de documentare pentru realizarea acestui raport de cercetare a culminat cu 

realizarea unei baze de date care să conţină informaţii cât mai detaliate privind fluviul Dunărea 

în general și sectorul Bechet-Corabia în special.  

Datele geospaţiale în format vectorial au fost organizate în straturi tematice numite 

“layere” (Tabelul 3), care să permită analize în mediul GIS (Sistem Informațional Geografic).  

De obicei, sursele de bază sunt datele de tip raster, care se vectorizează, rezultând alte 

date cărora li se adaugă o tabelă de atribute cu mai multe câmpuri caracteristice. Aceste câmpuri 

sunt folosite la rândul lor pentru design (etichete, clasificări) sau pentru a genera noi informații. 

 

Tabelul 3. Structura bazei de date geospaţiale de tip vector utilizate în studiu 

DATE DIGITALE 

PRIMARE 
FORMAT SURSA DATELOR 

Rețea hidrografică Vector; linie Vectorizarea hărții topografice 1:25000 

Stații hidrometrice Vector; punct Baza de date INHGA 

Localităţi Vector; punct geo-spatial.org 

Granița de stat Vector; poligon geo-spatial.org  

Limita A.B.A. Vector; poligon Baza de date INHGA 

Bazine hidrografice Vector; poligon Baza de date INHGA 

Maluri Vector; linie 
Vectorizare ortofotoplanuri cu rezoluția 

de 0,5 m (ediția 2013-2017);  

Albia majoră Vector; linie 
Vectorizare ortofotoplanuri cu rezoluția 

de 0,5 m (ediția 2013-2017); 

Talveg Vector; linie AFDJ Galați (proiect “Fast Danube”) 

Ostroave/ Insule fluviale Vector; poligon 
Vectorizare ortofotoplanuri cu rezoluția 

de 0,5 m (ediția 2013-2017);  

Diguri Vector; punct Baza de date INHGA  

Curbe de nivel Vector; linie Vectorizarea hărții topografice 1:25000 

Utilizare teren Vector; poligon 
Vectorizare Corine Land Cover 2012-

2018 

Soluri Vector; poligon Vectorizarea hărții solurilor 1:200000 

Geologie Vector; poligon 
Harta geologică a României, scara 

1:200000 
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Până la finalizarea proiectului de cercetare, această bază de date va fi completată și 

actualizată în mod constant, deoarece aplicarea operațiilor specifice GIS pe date vectoriale brute 

poate genera date în format raster, mult mai utile pentru analize şi previziuni asupra anumitor 

procese geomorfologice actuale, existând posibilitatea prelucrării lor pentru a simula condiţiile 

din teren şi a cuantifica influenţele acestora în declanşarea şi evoluţia unor procese invizibile 

ochiului uman sau nereprezentate pe harta topografică.  

3.4.4. Alte surse de date 

În general, procesele hidrologice, atât cele care caracterizează scurgerea lichidă, cât și 

cele care descriu scurgerea de aluviuni, se desfășoară la scara bazinelor hidrografice şi sunt 

determinate de o serie de factori de mediu, dintre care cei mai importanţi sunt substratul 

litologic (geologia), relieful, solurile, utilizarea terenului, elementele climatice și apele freatice. 

 

3.5. Etape de lucru  

Pentru descrierea și exemplificarea modurilor în care factorii hidrodinamici acționează 

asupra albiei fluviului și implicit asupra formațiunilor specifice patului de albie, au fost utilizate 

metode specifice modelării hidraulice coroborate cu tehnici geospațiale. 

 

3.5.1. Programe de specialitate utilizate  

Pentru digitizarea, prelucrarea și exportul datelor necesare modelării batimetrice, 

precum și pentru transpunerea spațială a datelor și a informațiilor în schițe și hărți au fost 

utilizate aplicațiile GIS: ArcMap 10.5, ArcGIS PRO 2.1 și Global Mapper v18. 

Modelul hidraulic 2D al zonei studiate (Bechet-Corabia) a fost elaborat cu ajutorul 

modulului hidrodinamic MIKE 21 Flow Model (FM) din pachetul software MIKE 21, dezvoltat 

de organizația internațională independentă de consultanță și cercetare DHI pentru modelarea 

2D a râurilor, valurilor, transportului sedimentar, calității apei și advecției/dispersiei 

(https://www.mikepoweredbydhi.com/). 

Soluția MIKE 21 Flow Model HD FM este bazată pe ecuaţiile Navier-Stokes integrate 

în raport cu adâncimea (pentru curgerea cu suprafaţă liberă) și utilizează o rețea de elemente 

finite (Flexible Mesh) [14]. Programul calculează nivelul apei, adâncimea, mărimea vitezei şi 

direcţia acesteia din fiecare element finit al rețelei modelului şi la fiecare interval de timp al 

simulării modelului. 

De asemenea, MIKE 21 FM permite simularea transportului de sedimente folosind un 

modul de transport de sedimente necoezive (”Sand Transport”), un modul de transport de 

sedimente coezive (”Mud Transport”) şi un modul de morfologie (pentru actualizarea cotelor 

din patul albiei pe parcursul simulării modelului). 

Modulul FM din pachetul MIKE 21 permite o simulare mai performantă a sistemelor 

combinate de sedimente grosiere şi fine decât alte module de curgere 2D, precum pachetul 

MIKE21C (care folosește o reţea cu ochiuri curbilinii), unde simularea transportului  

sedimentelor fine este mai simplistă.  

 

https://www.mikepoweredbydhi.com/
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3.5.2. Pregătirea datelor geospațiale utilizând aplicații GIS 

Cele mai importante informații în construirea modelului hidrodinamic bidimensional al 

curgerii sunt reprezentate de batimetrie, împreună cu topografia albiei majore sau, mai bine zis, 

modelul digital al terenului. După cum s-a menționat anterior, MDT-ul corespunzător sectorului 

Bechet-Corabia acoperă albia minoră a fluviului și 250 m de la limita apei. El provine din 

procesarea și  unificarea datelor LiDAR și a datelor batimetrice, fiind un MDT unitar de o 

acuratețe ridicată și o rezoluție spațială mare: 0.5 m x 0.5 m. 

De cele mai multe ori, procesul de modelare hidraulică 2D necesită o componentă 

hardware cu o configurație specială, pentru ca exportul/importul datelor și simulările pe zone 

întinse să se realizeze într-un timp rezonabil.  

Întrucât am avut la dispoziție un calculator performant, însă nu de calibrul unei stații 

grafice (Workstation) construite şi pregătite să reziste solicitărilor continue pe întreaga durată 

a unei zile, s-a optat pentru reeșantionarea MDT la o rezoluție spațială de 1 m x 1 m.   

Mai întâi, redimensionarea MDT-ului (fișier de tip raster) conform zonei de studiu s-a 

efectuat cu ajutorul funcției Extract by Mask din Modulul Spatial Analyst din ArcMap 10.5, 

apoi a fost accesată funcția Resample (Figura 18), care poate fi găsită în fereastra ArcToolbox: 

Data Management Tools → Raster → Raster processing → Resample. La “input” a fost selectat  

modelul numeric altitudinal al terenului, pentru X și Y am introdus valoarea 1, iar la Resampling 

Technique a fost selectată metoda Nearest.  

 
Figura 18. Reeșantionarea MDT folosind funcția Resample  

Soft-ul Global Mapper a fost utilizat pentru conversia acestui fișier raster din format 

.img în formatul acceptat de Mike 21, și anume .xyz, urmând pașii File → Export → Elevation 

Grid Format → XYZ Grid. Fișierul .xyz rezultat conține peste 100 milioane de puncte. 

Vectorizarea liniei malurilor, a albiei majore și a insulelor sau ostroavelor fluviale 

(Figura 21) s-a făcut în ArcMap 10.5, pe baza MDT, a ortofotoplanurilor ediția 2013-2017, 

respectiv 2017-2019 (figura 20) , cu rezoluția spațială de 50 cm, realizate de Direcția 

Topografică Militară, dar și pe baza imaginilor satelitare Sentinel 2 (Figura 19) din perioada 

campaniei de măsurători.  
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Pentru exportul datelor de tip shapefile în format .xyz, s-a utilizat unealta Shape to XYZ 

Conversion creată de DHI (distanța maximă setată între puncte a fost de 100 m). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ultima etapă de pregătire a datelor înaintea importului acestora în Mike 21 a constat în 

crearea fișierului .xyz cu valorile coeficientului de rugozitate Manning (M=1/n, unde n este 

coeficientul adimensional de rugozitate), care diferă pentru cursul principal, insule şi albia 

majoră, luând valori între 10 – 38.46 (Figura 22). Cu cat valoarea numărului Manning este mai 

mică, cu atât crește rezistența terenului (repectiv scade viteza de curgere) [15]. 

 

Figura 22. Coeficienții de rugozitate pentru albia majoră, albia minoră și insule 

Figura 201. Vectorizarea malurilor, albiei 

majore,  ostroavelor și insulelor fluviale pe baza 

MDT, ortofotoplanurilor și imaginilor 

satelitare Sentinel 2 (banda IR) 

Figura 210. MDT suprapus peste ortofotoplan  

Figura 19. Imagine satelitară Sentinel 2 

(IR – benzile 8, 4, 3) 
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3.5.3. Importul datelor geospațiale și generarea MESH în Mike 21  

În Mike Zero (denumirea interfeței grafice DHI din care se accesează toate modulele 

disponibile: Mike HYDRO, Mike 11, Mike 21, Mike 3, Mike Flood, Mike SHE etc.), se selectează 

New → File →Mesh Generator.  

Primul pas în obținerea grilei flexibile (triunghiulare) de elemente finite îl reprezintă 

setarea proiecției cartografice, și anume “Stereo_70” în cazul acestui studiu.   

Următorul pas constă în importarea limitelor domeniului de lucru în Mesh Generator: 

Data → Import Boundary, apoi se selectează fișierele .xyz (exportate anterior din mediul GIS) 

pentru ostroave, insule fluviale și pentru albia majoră. La “Boundary properties” se selectează 

“X, Y, Connectivity and Z” (Figura 23). 

 

 

Figura 23. Setarea proiecției și a tipului de fișier .xyz 

Foarte important de menționat faptul că se va bifa “Exclude from mesh” pentru toate 

ostroavele și insulele fluviale și ,,Apply triangular mesh” doar pentru cursul principal, deoarece 

se presupune că apa nu curge peste acele formațiuni insulare acoperite cu vegetație.  

După editarea vertecșilor și nodurilor limitelor domeniului, se va genera grila de 

elemente finite astfel: Mesh → Mesh Generation (figura 24), cu următoarele setări: 

- Maximum element area (aria maximă a elementului): 5000 m2; 

- Smallest allowable angle (cel mai mic unghi admis): 30; 

- Maximum number of nodes (număr maxim de noduri): 80000. 

 

Figura 24. Generarea rețelei de elemente finite 
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Prin această operație, domeniul modelului este reprezentat printr-o reţea de elemente  

finite triunghiulare interconectate Figura 25). O astfel de reţea este generată automat de 

sistemul de calcul, iar rezoluţia modelului este controlată prin specificarea ariei maxime pe care 

un element individual o poate ocupa în reţea. De exemplu, dacă suprafaţa maximă a elementului 

a fost setată la 5000 m2, atunci fiecare element din reţea va avea o suprafaţă de cel mult 5000 

m2. Rezoluţia reţelei poate varia în diferite părţi ale domeniului modelat (la final am aplicat și 

funcția “Smooth Mesh”). Pe măsură ce se reduce mărimea celulei, creşte atât numărul de 

elemente din model, cât şi timpul de calcul necesar simulării modelului.   

 

 

Figura 25. Reţea de elemente  finite triunghiulare interconectate (Triangular Mesh) 

După această etapă, au fost importate în Mesh punctele rezultate din exportul MDT-ului 

în format .xyz, prin accesarea instrumentului “Manage Scatter Data” din meniul Data.  

 

 

Figura 26. Importarea fișierului .xyz cu punctele extrase din MDT 
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Interpolarea acestor milioane de puncte utilizând funcția “Interpolate” din meniul 

“Mesh” reprezintă ultimul pas în obținerea fișierului de batimetrie. Cotele punctelor sunt 

exprimate în sistemul de altitudini Marea Neagră 1975 (figura 27).  

Rezultatul a fost ulterior exportat accesând meniul Mesh → Export Mesh → Mesh File 

(Item type - Bathymetry). 

 

 

 Figura 27. Fișierul Mesh pentru batimetria sectorul dunărean Bechet - Corabia 

În mod asemănător, a fost importat în Mesh fișierul .xyz cu coeficienții Manning de 

rugozitate – bed resistance (creat în ArcMap): Data → Manage Scatter Data (figura 28).  

 

 

Figura 28. Importarea fișierului .xyz cu coeficienții Manning de rugozitate 

Aceste valori au fost interpolate, iar rezultatul a fost exportat ca DFSU Data-file (din 

meniul Mesh → Export Mesh), un format specific Mike, cu precizarea  “Manning’s M” pentru 

Item type.      

 

Figura 29. Fișierul .dfsu pentru rugozitatea sectorului dunărean Bechet - Corabia 
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3.5.4. Introducerea condițiilor la limită 

Stabilirea condițiilor la limită (Boundary conditions) pentru model se referă la: 

 Introducerea hidrografului debitelor în secțiunea din amonte (s.h. Bechet) corespunzător 

perioadei de simulare; 

 Introducerea cheii limnimetrice în secțiunea din aval (s.h. Corabia), valabilă la nivelul 

anului 2017.  

De asemenea, a fost necesară introducerea unei condiții inițiale (Initial Condition), care 

constă în: 

 Introducerea unui debit constant în secțiunea din amonte - și s-a optat pentru debitul mediu 

pentru anul 2017 de la s.h. Bechet (4461 m3/s) 

 Introducerea cheii limnimetrice în secțiunea din aval (s.h. Corabia). 

Pentru a stabili aceste condiții la limită utilizând Mike, se impune crearea unor fișiere .dfs0, 

atât pentru hidrograful debitelor de la s.h. Bechet (Figura 30), cât și pentru cheia limnimetrică 

de la s.h. Corabia (Figura 31).  

a) Pentru debite: 

 Din Mike Zero se selectează New → File → Time Series (.dt0, .dfs0) → Blank Time 

Series, iar în fereastra care se deschide se fac următoarele setări (în limba engleză) 

pentru tipul axei, data de început, pasul de timp, numărul de pași de timp, denumirea 

fișierului, tipul înregistrării, unitatea de măsură: 

- Axis Type: Equidistant Calendar Axis (axă de timp echidistantă); 

- Start time: 23.04.2017 (au fost consultate rapoartele de pe site-ul proiectului Fast Danube 

pentru a verifica perioadele în care s-au efectuat măsurătorile batimetrice în acest sector 

(http://www.fastdanube.eu/); 

- Time step: 1 day; 

- Number of Time Steps: 44; 

- Name: Debite Bechet; 

- Type: Discharge (debit); 

- Unit: m3/s; 

    Debitele introduse în fișierul .dfs0 corespund celor din perioada de simulare a modelului 

(23.04.2017 – 05.06.2017). 

 

Figura 30. Fișier .dfs0 cu hidrograful debitelor (s.h. Bechet)  

http://www.fastdanube.eu/
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b) Pentru cheia limnimetrică: 

 Din Mike Zero se selectează New → File → Time Series (.dt0, .dfs0) → Blank Time 

Series, iar în fereastra care se deschide se fac următoarele setări: 

- Axis Type: Relative Item Axis; 

- Number of Time Steps: 467 (câte rânduri sunt în cheia limnimetrică în format .xls); 

- Axis Units: m; 

- Name: Cheie Corabia; 

- Type: Water level (nivelul apei); 

- Unit: m; 

 

Figura 31. Fișier .dfs0 cu cheia limnimetrică valabilă pentru anul 2017 (s.h. Corabia)  

Fișierul .dfs0 cu cheia limnimetrică valabilă pentru anul 2017 la s.h. Corabia va fi folosit 

atât pentru rularea condiției inițiale (cu debit constant), cât și pentru condiția la limită din aval 

a modelului final.  

 

3.5.5. Setarea modelului Mike 21 Flow Model (FM)  

După prelucrarea tuturor datelor și pregătirea fișierelor în formate specifice Mike 21, 

pentru a seta modelul Mike 21 FM, au fost urmați pașii: Mike Zero → Mike 21 → Flow Model 

FM, apoi se va deschide fereastra din figura 32:  

 

Figura 32. Modulul Mike 21 FM  
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Aici vom introduce următoarele informații și seturi de date: 

 Domain (domeniul de lucru): fișierul .mesh creat anterior pentru batimetria sectorului 

dunărean Bechet – Corabia; 

 Time (perioada de timp): 23.04.2017 – 05.06.2017, însemnând 44 de zile, cu un pas de 

timp de 30 s, rezultând un număr total de pași de timp de 123840; 

 Modul selection (modulul selectat): Hydrodynamic. 

 

 Modulul Hydrodinamic a fost setat astfel:  

 

 Solution technique (soluția tehnică): Low order, fast algorithm (în acest fel simularea 

este mai rapidă); 

 Flood and dry: Drying depth – 0.01m; Wetting depth – 0.1 m; 

 Density (densitatea): Barotropic; 

 Eddy Viscosity (vâscozitatea Eddy): Constant eddy formulation; 

 Bed resistence (rugozitatea): Manning number – a fost introdus fișierul .dfsu creat 

anterior; 

 Initial condition (condiția inițială): a fost selectat fișierul .dfsu rezultat la simularea cu 

debit constant (4461 m3/s) în amonte și cheia limnimetrică în aval; Item: Surface 

elevation; 

 Boundary conditions (condițiile la limită): în amonte se introduce fișierul .dfs0 cu 

hidrograful debitelor (s.h. Bechet) – Type: Specified discharge, Format: Strong 

formulation, Varying in time; iar în aval fișierul .dfs0 cu cheia limnimetrică valabila 

pentru anul 2017 la s.h. Corabia – Type: Specified level, Format: Rating Curve.  

 Output items (rezultatele obținute – figura 33): Surface elevation, Total water depth, 

Current Speed, U velocity, V velocity.  

 
      Figura 33. Rezultatele simulării 



   Raport de cercetare nr. 2  

Modelarea batimetrică – premisa pentru crearea de modele ale curgerii și transportului de sedimente 

34 
 

4.  REZULTATE ȘI CONCLUZII 
 

La finalul simulării (de aproximativ 38 ore) au fost calculate, pentru fiecare pas de timp 

și în fiecare element finit al rețelei modelului: nivelul apei raportat la MN75 (Surface elevation) 

– figura 34, adâncimea apei (Total water depth) – figura 35, viteza curentului (Current speed) 

– figura 36 şi direcţia vitezei (componentele U și V – U velocity, V velocity) – figura 37 și 

figura 38. Aceste informații sunt stocate într-un fișier în format .dfsu.  

Etimologic, conceptul de ,,simulare” provine din latinescul simulatio, care reprezintă 

capacitatea de a reproduce, a imita sau a reprezenta un fenomen.   

 

 

Figura 34. Nivelul Apei (Surface elevation) 

 

Figura 35. Adâncimea apei (Total water depth)  

 

Figura 36. Viteza curentului (Current speed) 
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Figura 37. Componenta U a vitezei (U velocity) 

 

Figura 38. Componenta V a vitezei (V velocity) 

 

Pentru a demonstra capabilitatea modelului hidrodinamic bidimensional de a reproduce 

cu o mare precizie comportamentul oricărui alt eveniment hidrologic similar, următoarea etapă 

a studiului constă în calibrarea şi validarea acestuia.  

 

 Calibrarea modelului hidrodinamic 2D 

În general, calibrarea modelului se realizează prin modificarea coeficienților de 

rugozitate în albia minoră, astfel încât diferențele dintre cheia limnimetrică măsurată și cheia 

limnimetrică modelată să fie mai mici de 10 cm. 

În acest scop, a fost creat un model hidraulic 1D cu ajutorul modulului MIKE Hydro 

River, pe baza a 27 de secțiuni transversale extrase din MDT-ul avut la dispoziție pentru 

sectorul critic Bechet-Corabia și păstrând în rest aceleași date de intrare ca și pentru modelul 

2D, inclusiv perioada de simulare fiind comună (23.04.2017-05.06.2017).  

Valorile coeficienților de rugozitate au fost definite pe baza ortofotoplanurilor și a 

stratului Corine Land Cover, separat pentru albia majoră, insule şi cursul principal.  Rugozitatea 

depinde de dimensiunea particulelor care compun patul albiei. 

După rularea modelului 1D în regim nepermanent, cu valorile M ajustate anterior, s-a 

comparat  hidrograful nivelurilor zilnice simulate cu hidrograful nivelurilor zilnice măsurate la 

s.h. Corabia (date puse la dispoziție de către I.N.H.G.A.), diferențele între nivelul simulat și cel 

măsurat încadrându-se în intervalul [-10.3 cm, +7.9 cm], cu o medie a acestora de -1.6 cm 

(Figura 39).     
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                           Figura 39. Calibrarea modelului hidrodinamic 1D 

Pentru calibrarea modelului 2D, s-a utilizat fișierul obținut prin ajustarea valorilor 

coeficienților de rugozitate, în urma testelor efectuate prin modelare 1D. 

Cu ajutorul modulului “Data extraction FM” accesat din MIKE Zero, au fost extrase, 

din modelul 2D, nivelurile zilnice ale apei (în sistem de altitudini MN75) corespunzătoare 

secțiunii s.h. Corabia, ca serie temporală, pentru a le compara cu hidrograful nivelurilor zilnice 

măsurate pus la dispoziție de INHGA. Diferențele între nivelurile zilnice simulate și cele 

măsurate s-au încadrat în intervalul [-5.35 cm, +12.35 cm], cu o medie a acestora de +2.25 cm 

(Figura 40). Prin obținerea acestor valori, se consideră că modelul a fost calibrat cu succes.    

 

Figura 40. Calibrarea modelului hidrodinamic 2D 
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 Validarea modelului hidrodinamic 2D 

Validarea modelului hidraulic presupune utilizarea în modelarea numerică a unor 

seturi de date hidrologice diferite față de cele utilizate în etapa de calibrare. Pentru a demonstra 

stabilitatea modelului hidrodinamic bidimensional, rezultatele simulărilor trebuie să fie cât mai 

apropiate de datele obținute din măsurători.   

În cazul de față, validarea s-a realizat simulând debitele zilnice înregistrate la stația 

hidrometrică Bechet în perioada 03.03.2017 – 31.03.2017. Debitul maxim din această perioadă 

de validare a fost de 8010 m3/s, iar cel minim de 6010 m3/s, față de maximul de 7270 m3/s și 

minimul de 4300 m3/s înregistrate în perioada de calibrare, 23.04.2017-05.06.2017.  

 

Figura 41. Validarea modelului hidrodinamic 2D (perioada 03.03.2017-31.03.2017) 

La finalul simularii, care a avut un timp de rulare de 24 de ore, s-a extras hidrograful 

nivelurilor corespunzătoare secțiunii s.h. Corabia, cu ajutorul modulului “Time Series 

Comparator”, pentru a fi comparat cu hidrograful nivelurilor măsurate la stația hidrometrică în 

perioada 03.03.2017 – 31.03.2017. Diferențele între nivelurile zilnice simulate și cele măsurate 

se încadrează în intervalul [-3.44 cm, +8.76 cm], cu o medie a acestora de +2.24 cm (Figura 

41).   

 Concluzii: 

 Rezultatele obținute în urma proceselor de calibrare și validare confirmă faptul că modelul 

2D elaborat poate reproduce cu un nivel înalt de încredere comportamentul oricărui alt 

eveniment hidrologic similar. 

 Acest model hidraulic 2D constituie baza pentru realizarea unui model de eroziune pentru 

sectorul critic Bechet-Corabia. 
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